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ID TECH SOFTWARE COPYRIGHT NOTICE

Copyright 2010-2013 International Technologies & Systems Corporation. All rights
reserved. ID TECH is a registered trademark of International Technologies & Systems
Corporation. Value through Innovation, Spectrum is trademarks of International
Technologies & Systems Corporation.

ID TECH SOFTWARE LICENSE AGREEMENT

ID TECH ("LICENSOR") IS WILLING TO LICENSE THIS SOFTWARE TO YOU
ONLY IF YOU ACCEPT ALL OF THE TERMS IN THIS LICENSE AGREEMENT.
PLEASE READ THE TERMS CAREFULLY BEFORE YOU AGREE BECAUSE
YOU WILL BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO
NOT AGREE TO THESE TERMS, LICENSOR WILL NOT LICENSE THIS
SOFTWARE TO YOU.

Ownership of the Software

1. The Licensor software program ("Software™) and any accompanying written
materials are owned by Licensor [or its suppliers] and are protected by United States
copyright laws, by laws of other nations, and by international treaties.

Grant of License

2. Licensor grants to you the right to use the Software in conjunction with an ID
TECH product. You may load one copy into permanent memory of one computer and
may use that copy only on that same computer.

Restrictions on Use and Transfer

3. You may not copy the Software, except that (1) you may make one copy of the
Software solely for backup or archival purposes, and (2) you may transfer the
Software to a single hard disk provided you keep the original solely for backup or
archival purposes. You may not copy the written materials.

4. You may permanently transfer the Software and any accompanying written
materials (including the most recent update and all prior versions) if you retain no
copies and the transferee agrees to be bound by the terms of this Agreement. Such a
transfer terminates your license. You may not rent or lease the Software or otherwise
transfer or assign the right to use the Software, except as stated in this paragraph.

5. You may not reverse engineer, decompile, or disassemble the Software.
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Limited Warranty

6. If used in conjunction with an ID TECH product, Licensor warrants that the
Software will perform substantially in accordance with the accompanying written
materials for a period of 90 days from the date of your receipt of the Software. Any
implied warranties on the Software are limited to 90 days. Some states and territories
do not allow limitations on duration of an implied warranty, so the above limitation
may not apply to you.

7. LICENSOR DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NON-INFRINGEMENT, WITH RESPECT TO THE SOFTWARE AND ANY
ACCOMPANYING WRITTEN MATERIALS. This limited warranty gives you
specific legal rights. You may have others, which vary from state to state.

8. LICENSOR'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY
SHALL BE REPLACEMENT OF THE SOFTWARE THAT DOES NOT MEET
LICENSOR'S LIMITED WARRANTY. Any replacement Software will be warranted
for the remainder of the original warranty period or 30 days, whichever is longer.

9. This Limited Warranty is void if failure of the Software has resulted from
modification, accident, abuse, or misapplication.

10. IN NO EVENT WILL LICENSOR BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE
OR INABILITY TO USE THE SOFTWARE. Because some states do not allow the
exclusion or limitation of liability for consequential or incidental damages, the above
limitation may not apply to you.

11. This Agreement is governed by the laws of the state of California.

12. If you have any questions concerning this Agreement or wish to contact Licensor
for any reason, please write: ID TECH, 10721 Walker Street, Cypress, CA 90630 or
call (714) 761-6368.

13. U.S. Government Restricted Rights. The Software and documentation are
provided with Restricted Rights. Use, duplication, or disclosure by the Government is
subject to restrictions set forth in subparagraph (c)(1) of The Rights in Technical Data
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1)(ii)
and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19,
as applicable. Supplier is ID TECH, 10721 Walker Street, Cypress, CA 90630.
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1. Description

The documentation describes the properties, methods, and events of the ID TECH
SecuRED MSR OPQOS component. The component includes two parts: a Control
Object running on the upper level, which is an ActiveX control, and a Service Control
running on the lower level, which is an OLE automation server. The properties,
methods, and events are exposed by the Control Object. When the Control Object is
imported into your project as an ActiveX control, you will see all the properties,
methods, and events.

For different interface devices, OPOS drivers may be different. For USB HID
Keyboard interfaces device, the standard keyboard should not be pressed when
swiping cards, otherwise the card data will be wrong , MSR OPQOS Driver will display
a warning dialog and the data will be discarded.

The SecuRED MSR device can’t support hot plug when OPOS driver is in the Open
state. If you have already pulled out the device in Open state, close driver and reopen
can use again.

For the same interface SecURED MSR devices, the OPOS supports only one device
for use on a computer. In other words: at the same time, the OPOS only allows to
connect one device.

If the SecuRED MSR Device has been authenticated, the application should cancel
the authentication before close the OPOS. Otherwise, the device will stay in the
authentication state 120 seconds.

Target Device:
ID TECH SecuRED
USB-HID, USB-KB interface

Platform:

Microsoft Windows 8,Windows 7,Vista, XP, 2000, 98.
Service Object and Control Object:

Service Object Version: 1.13.309

Control Object Version: 1.13.001

DIl File Version: 3.0.9
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2. Methods, Properties and Events of SecuRED
This section describes methods, properties and events for the SecuRED Encrypted
MSR.

2.1. Methods of MSR
These function declarations may be different when the Control Object
(OPOSMSR.OCX) is imported into your application project. Please refer to the
UnifiedPOS Specification for more detailed information on the Control Object.

1) Open
Syntax LONG Open (BSTR DeviceName);
DeviceName:
For USB HID interface: “IDTECH_ SECURED _USBHID”
For USB KB interface: “IDTECH_ SECURED _USBKB”
Remarks Call to open a device for subsequent 1/0.
Support?  Yes
Description This method finds more parameters in the Windows Register Tables on
key or sub keys.

For USB HID interface:
HKEY_LOCAL_MACHINE\Software\OLEforRetail\ServiccOPOS\MSR\
IDTECH_SECURED _USBHID\ CONNECTOR

Key value name: USBHID

Key value: "usbhidConn.dll"

Key value name: CONNECTOR

Key value: "USBHID/0acd/2810"

First field USBHID specify the type of the connector. Oacd is the USB device
vendor 1D, 2810 is the reader product ID.

For USB KB interface:
HKEY_LOCAL_MACHINE\Software\OLEforRetail\ServiccOPOS\MSR\
IDTECH_SECURED USBKB\ CONNECTOR

Key value name: USBKB

Key value: "usbkbConnector.dll*

Key value name: CONNECTOR

Key value: "USBKB/0acd/2820"

First field USBKB specify the type of the connector. Oacd is the USB device
vendor 1D, 2820 is the reader product ID.

2) ClaimDevice  Added in Release 1.5
Syntax LONG ClaimDevice (LONG Timeout);
7
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Remarks  Call this method to request exclusive access to the device. Many devices
require an application to claim them before they can be used. Release 1.0 -1.4in
releases prior to 1.5, this method is named Claim.

Support? Yes

3) CheckHealth

Syntax LONG CheckHealth (LONG Level);

Remarks Called to test the state of a device.

Support? Yes

Description When select CH_INTERNAL, check the SO response, if not it tells that
there is something wrong with the device. CheckHealthText property will be “Internal
HCheck: Successful”

When select CH_EXTERNAL, SO will return the firmware version of the
SecuRED device, if reading the firmware version is successful. CheckHealthText
property will be “External HCheck: Successful” + firmware version information. If
Not Responding, CheckHealthText property will be “External HCheck: Not
Responding”.

When select CH_INTERACTIVE , SO will display a dialog, which include
firmware version and swiping card. And it can display the “Real data” of the card;
include Start Sentinel and End Sentinel. CheckHealthText property will show
“External HCheck:: HCheck: Complete”, after the dialog is closed.

4) Clearlnput

Syntax LONG ClearInput ();

Remarks Called to clear all device input that has been buffered.
Support? Yes

5) DirectlO

Syntax LONG DirectlO (LONG Command, LONG* pData, BSTR* pString);
Remarks  Call to communicate directly with the Service Object.

Support? No

Description In the current, it implemented incompletely. We will improve it in the
next release.

6) ReleaseDevice Added in Release 1.5
Syntax LONG ReleaseDevice ();
Remarks  Call this method to release exclusive access to the device.
Release 1.0-1.4
In releases prior to 1.5, this method is named Release.
Support? Yes

7) Close

Syntax LONG Close ();

Remarks Called to release the device and its resources.
8
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Support?  Yes

8) ResetStatistics Added in Release 1.8

Syntax LONG ResetStatistics(BSTR m_StatisticsBuffer);

Remarks Called to Resets the defined resettable statistics in a device to zero.
Support? No

9) RetrieveStatistics Added in Release 1.8

Syntax LONG RetrieveStatistics(BSTR* m_pStatisticsBuffer);
Remarks Called to Retrieves the requested statistics from a device.
Support? No

10) UpdateStatistics Added in Release 1.8

Syntax LONG UpdateStatistics(BSTR m_StatisticsBuffer);
Remarks Called to Updates the defined resettable statistics in a device.
Support? No

11) CompareFirmwareVersion

Syntax LONG CompareFirmwareVersion(BSTR m_FirmwareFileName,
long* m_pResult);

Remarks Called to compare the firmware version with current firmware version of

the device.

Support? No

12) UpdateFirmware

Syntax LONG UpdateFirmware(BSTR m_FirmwareFileName);
Remarks Called to update current firmware.

Support? No

13) ClearInputProperties

Syntax void ClearInputProperties();

Remarks Sets all data properties that were populated as a result of firing a
DataEvent or ErrorEvent back to their default values.

Support?  Yes

14) WriteTracks

Syntax long WriteTracks(LPCTSTR data, long timeout)

Remarks  Sets all data properties that were populated as a result of firing a
DataEvent or ErrorEvent back to their default values.

Support? No

15) AuthenticateDevice

Syntax long AuthenticateDevice (LPCTSTR response)

Remarks  To authenticate a device, the application first calls the
9



SecuRED OPOS User Manual

retrieveDeviceAuthenticationData method to retrieve a challenge token
from the device. The application then typically passes this token to
another entity that has special knowledge of a shared secret and is able to
create a proper response token. This response token is then passed as the
response parameter to this method and the service uses it to validate the
authentication request. If this method succeeds, the device enters the
authenticated state and the service sets the DeviceAuthenticated property
to true.
For SecuRED: The response needs to be 16 bytes in length. And it
should be transmitted as a Hex string. Example, OXAB 0x00 0x09 is
converted to "AB0009".

Support?  Yes

16) DeauthenticateDevice

Syntax long DeauthenticateDevice (LPCTSTR response)

Remarks  This method is used to deauthenticate a device that is currently in the
authenticated state (DeviceAuthenticated = true). The token is typically
generated by passing the challenge retrieved from the
retrieveDeviceAuthenticationData method to an entity that has special
knowledge of a shared secret. If this method succeeds the service sets
DeviceAuthenticated to false and enqueues a StatusUpdateEvent with
status value set to MSR_SUE_DEVICE_DEAUTHENTICATED.

For SecuRED: The response needs to be 16 bytes (when Encryption
Algorithm is 3DES) or 8 bytes (when Encryption Algorithm is AES) in
length. And it should be transmitted as a Hex string. Example, OXAB
0x00 0x09 is converted to "AB0009".

Support?  Yes

17) RetrieveCardProperty
Syntax long RetrieveCardProperty (BSTR Name, BSTR *Value)
Remarks Retrieves the value of specific parsed properties from the
last card swiped.
Support?  Yes

10
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18) RetrieveDeviceAuthenticationData

Syntax
Remarks

Support?

long RetrieveDeviceAuthenticationData (LPCTSTR challenge)
Applications call this method to retrieve a challenge token that will
subsequently be used to generate response tokens that will be passed to
the authenticateDevice and deauthenticateDevice methods. The
challenge token is typically sent to another entity that has special
knowledge of a shared secret that is required to generate the proper
response token(s).

For SecuRED: The challenge is always 26 bytes in length. And it will be
transmitted as a Hex string. Example, OXAB 0x00 0x09 is converted to
"AB0009".

Yes

19) UpdateKey

Syntax
Remarks

Support?

long UpdateKey (BSTR Key, BSTR KeyName)

Provides a new encryption key to the device. It is used only for those
encryption algorithms in which new key values are sent to the terminal
as a field in standard messages from the host.

NO

2.2. Properties of MSR
Please refer to the UnifiedPOS Specification for detailed information.
NOTE: CO --- Control Object

SO --- Service Object
AP or App --- the abbreviation of Application.

11




SecuRED OPOS User Manual

Property Groupl---Description

Name Type | Mutability | Use Description Support?
After
DeviceControlDescri | String | read-only | -- Identify the Control Object and Yes
ption the company that produced it
DeviceControlVersio | int32 | read-only | -- Hold the Control Object version | Yes
n number.
DeviceServiceDescrip | String | read-only | open | ldentify the Service Object Yes
tion supporting the device and the
company that
produced it
DeviceServiceVersion | int32 | read-only | open | Hold the Service Object version | Yes
number.
PhysicalDeviceDescri | string | read-only | open | ldentify the device and any Yes
ption pertinent information about it.
PhysicalDeviceName | string | read-only | open | ldentify the device and any Yes
pertinent information about it.
Property Group2---Control
Name Type Mutability | Use Description Support?
After
Claimed Boolean | read-only | open SecuRED must be claimed for Yes
exclusive use before access its
methods and properties, and
before any events to be fired. It
is initialized to FALSE by the
Open method. It is set to TRUE
after the method Claim is
successfully called.
AutoDisable Boolean | read-write | open When TRUE, as soon as an event | Yes
DataEvent is received, then
DeviceEnabled is automatically
to FALSE. It is initialized to
FALSE by the Open method.
DeviceEnabled Boolean | read-write | open& | When FALSE, SecuRED has Yes
claim been disabled and any subsequent
input will be discarded (No
DataEvent could be received even
if the card is swiped). It is
initialized to FALSE by the Open

12
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method.

FreezeEvents

boolean

read-write | open When TRUE, events are not
required to be delivered and will
be held by SO until events are
unfrozen. It is initialized to
FALSE by the Open method.

Yes

DataEventEnabled

boolean

read-write | open When TRUE, a DataEvent or
ErrorEvent will be delivered
immediately when had. (Of
course, FreezeEvents=FALSE
and DeviceEnabled=TRUE is a
prerequisite). It is initialized to
FALSE by the Open method.

Yes

CapPowerReportin
g

int32

read-only | open Identifies the reporting
capabilities of the device about
Power. It seems that SecuRED
doesn’t support in the hardware.

No

PowerNotify

int32

read-write | open Contains the type power
notification selection made by the
Application. is initialized to
OPOS_PN_DISABLED by the
Open method.

No

PowerState

int32

read-only | open Contains the current power
condition. It seems that
SecuRED doesn’t support in the
hardware.

No

State

int32

Read-only | -- Contains the current state of the
Control. It can be set to one of the
four

Values: Closed, Idle, Busy, or
Error.

Yes

DataCount

int32

Read-only | open Holds the number of queued
DataEvents remained in the
queue.

Yes

CheckHealthText

string

read-only | open Holds the results of the most
recent call to the CheckHealth
method. Before the first
CheckHealth method call, its
value is uninitialized.

Yes

13
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Property Group3---Track Control

Name

Type

Mutability

Use
After

Description

Support?

CaplSO

boolean

read-only

open

If TRUE, SecuRED
supports 1SO cards.

Yes

CapJISOne

boolean

read-only

open

If TRUE, SecuRED
supports JIS Type-I
cards. JIS-I cards are a
superset of ISO cards.
Therefore, if
CapJISOne is true, it is
implied that CaplSO is
also TRUE.

No

CapJISTwo

boolean

read-only

open

If TRUE, SecuRED
supports JIS type-l1I
cards.

No

CapTransmitSentinels

boolean

read-only

open

If TRUE, SecuRED is
able to transmit the start
and end sentinels. e.g.
start sentinel could be
‘%"’ or ‘;’, and stop

sentinel could be ?°.

Yes

DecodeData

boolean

read-write

open

If TRUE, each byte of
track data properties is
mapped from its original
encoded bit sequence (as
it exists on the magnetic
card) to its
corresponding decoded
ASCII bit sequence.

Yes

ParseDecodeData

boolean

read-write

open

When TRUE, the
decoded data contained
within the Track1Data
and Track2Data
properties is further
separated into fields for
access via various other
properties. If
DecodeData=FALSE,
ParseDecodeData must
be false.

Yes

TransmitSentinels

boolean

read-write

open

If TRUE, the

Yes

14
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TracklData,
Track2Data,
Track3Data, and
Track4Data properties
contain start and end
sentinel values.
Otherwise only the track
data between these
sentinels.

TracksToRead

int32

read-write

open

Indicate which track
data that the App wishes
to get following a card
sweep.

Yes

ErrorReportingType

int32

Read-write

open

Holds the type of errors
to report via
ErrorEvents. This
property has one of the
following values:
MSR_ERT_CARD or
MSF_ERT_TRACK

Yes

Property Group4---TrackData

Name

Type

Use
After

Mutability

Description

Support?

TracklData

binary

read-only open

Holds the track 1 data
obtained from the most
recently swept card. If
DecodeData is true, then it
has been decoded from the
“raw” format. it may also be
parsed into other properties
when the ParseDecodeData
property is set.

Yes

Trackl1DiscretionaryD
ata

binary

read-only open

Holds the track 1
discretionary data obtained
from the most recently swept
card. It may be NULL
when:

1) The field was not included
in the track data obtained, or,

2) The track data format was

Yes

15
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not supported, 3)
ParseDecodeData is false.

Track2Data

binary

read-only

open

Holds the track 2 data
obtained from the most
recently swept card. If
DecodeData is true, then it
has been decoded from the
“raw” format. it may also be
parsed into other properties
when the ParseDecodeData
property is set.

Yes

Track2DiscretionaryD
ata

binary

read-only

open

Holds the track 2
discretionary data obtained
from the most recently swept
card. Itmay be NULL
when:

1) The field was not included
in the track data obtained, or,
2) The track data format was
not supported, 3)
ParseDecodeData is false.

Yes

Track3Data

binary

read-only

open

Holds the track 3 data
obtained from the most
recently swept card.

Yes

Track4Data

binary

read-only

open

Holds the track 4 data (JIS-11)
obtained from the most
recently swept card.

No

TracklEncryptedData

binary

read-only

Open

Holds the encrypted track 1
data obtained from the most
recently swiped card. The
start and end sentinel values
are contained in it, and
appear only after data is
decrypted.

Encrypted data is always a
multiple of 8 bytes (when
Encryption Algorithm is
3DES) or 16 bytes (when
Encryption Algorithm is
AES) in length. And it will
be transmitted as a Hex
string. Example, OxAB 0x00
0x09 is converted to

Yes

16
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"AB0009".

Track1lEncryptedData
Length

int32

read-only

Open

Holds the length of the raw
track 1 data before it was
encrypted.

Yes

Track2EncryptedData

binary

read-only

Open

Holds the encrypted track 2
data obtained from the most
recently swiped card. The
start and end sentinel values
are contained in it, and
appear only after data is
decrypted.

Encrypted data is always a
multiple of 8 bytes (when
Encryption Algorithm is
3DES) or 16 bytes (when
Encryption Algorithm is
AES) in length. And it will
be transmitted as a Hex
string. Example, 0XAB 0x00
0x09 is converted to
"AB0009".

Yes

Track2EncryptedData
Length

int32

read-only

Open

Holds the length of the raw
track 2 data before it was
encrypted.

Yes

Track3EncryptedData

binary

read-only

Open

Holds the encrypted track 3
data obtained from the most
recently swiped card. The
start and end sentinel values
are contained in it, and
appear only after data is
decrypted.

Encrypted data is always a
multiple of 8 bytes (when
Encryption Algorithm is
3DES) or 16 bytes (when
Encryption Algorithm is
AES) in length. And it will
be transmitted as a Hex
string. Example, OxAB 0x00
0x09 is converted to
"AB0009".

Yes

Track3EncryptedData
Length

int32

read-only

Open

Holds the length of the raw
track 3 data before it was

Yes

17
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encrypted.

Track4EncryptedData

binary

read-only

Open

Holds the encrypted track 4
data obtained from the most
recently swiped card.

No

Track4EncryptedData
Length

binary

read-only

Open

Holds the length of the raw
track 4 data before it was
encrypted.

No

AdditionalSecurityInf
ormation

binary

read-only

Open

Holds additional
security/encryption
information when a
DataEvent is delivered. For
example “DUKPT sequence
number” in it.

This data is always 10 bytes
in length. And it will be
transmitted as a Hex string.
Example, OXAB 0x00 0x09 is
converted to "AB0009".

Yes

CardAuthenticationD
ata

binary

read-only

Open

Holds card authentication
information when a
DataEvent is delivered.

No

CardAuthenticationD
ataLength

int32

read-only

Open

This property will be zero if
CapCardAuthentication is an
empty string.

No

DeviceAuthenticated

boolean

read-only

Open

Claim

Enabl

If the device supports
authentication the service
must keep the value of this
property up to date when the
device is enabled.
MSR_SUE_DEVICE_AUTH
ENTICATED or
MSR_SUE_DEVICE_DEAU
THENTICATED.

Yes

CardType

string

read-only

open

Holds the card type identifier
for the most recently swiped
card. Value is one of them
(“BANK”,”AAMVA” and

empty).

Yes

CardTypeList

string

read-only

open

Holds a comma separated list
of string names of card types
supported by the Service.
Value is BANK and
AAMVA.

Yes

18
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CardPropertyList

string

read-only

open

Holds a comma separated list
of the names of the properties
parsed from the most recently
swiped card.

Yes

Property Group5---ParsedData

Name

Type

Mutability

Use
After

Description

Support?

AccountNumber

string

read-only

Open

Holds the account number
obtained from the most
recently swept card.

itis initialized to NULL if:
1) The field was not included
in the track data obtained, or,
2) The track data format was
not supported, or, 3)
ParseDecodeData is false.

Yes

ExpirationData

string

read-only

Open

Holds the expiration date
obtained from the most
Others
are same as AccountNumber.

recently swept card.

Yes

FirstName

string

read-only

Open

Holds the first name obtained
from the most recently swept
card. Others are same as

AccountNumber.

Yes

Middlelnitial

string

read-only

Open

Holds the middle initial
obtained from the most
recently swept card. Others
are same as AccountNumber.

Yes

Surname

string

read-only

Open

Holds the surname obtained
from the most recently swept
card. Others are same as
AccountNumber.

Yes

Title

string

read-only

Open

Holds the title obtained from
the most recently swept card..
Others are same as
AccountNumber.

Yes

Suffix

string

read-only

Open

Holds the suffix obtained from
the most recently swept card..
Others are same as
AccountNumber.

Yes

19
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ServiceCode string read-only Open | Holds the service code Yes
obtained from the most
recently swept card. Others
are same as AccountNumber.
Property Group6--- Statistic
Name Type Mutability | Use Expected Result Test
After Result
CapStatisticsReporting | boolean | read-write | Open If true ,the SO can get device No
information to a XML statistics
CapUpdateStatistics boolean | read-write | Open If true ,the SO can update the No
XML statistics
Property Group7---Firmware
Name Type Mutability | Use Expected Result Test
After Result
CapCompareFirmware | boolean | read-write | Open If true ,the SO can compare the | No
Version Firmware version
CapUpdateFirmware boolean | read-write | Open If true ,the SO can update the No
firmware of the device
CapWritableTracks Int32 read_only Open This capability indicates if the No
SecuRED device supports the
writing of track data - and
which tracks are supported.
EncodingMaxLength Int32 read_only Open The maximum length of data No
that can be written by the
SecuRED to the track(s).
TracksToWrite Int32 Read-Write | Open Holds the SecuRED track(s) No
that will be written.
CapDataEncryption Int32 read_only Open Holds a bitwise indication of Yes
the encryption algorithms
supported by the device and
selectable via the

20
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DataEncryptionAlgorithm
property. MSR_DE_NONE:
Data encryption is not enabled.
MSR_DE_3DEA_DUKPT:
Triple DES Derived Unique
Key Per Transaction.
MSR_DE_AES _DUKPT
(value:3): Advanced
Encryption Standard Derived
Unique Key Per Transaction.

DataEncryptionAlgorit
hm

Int32

Read-Write

Open

Claim

Holds the encryption algorithm
that will be used to encrypt the
track data. This property may
be set to one of the supported
encryption algorithms as
defined in the
CapDataEncryption property.
MSR_DE_NONE: Data
encryption is not enabled.

Yes

CapTrackDataMaskin
g

boolean

Read_only

Open

This value will be true if the
Service is capable of masking
track data.

Yes

CapCardAuthenticatio
n

string

Read_only

Open

Holds the type, if any, of card
authentication data that is
supported by the device.

No

CapDeviceAuthenticati
on

Int32

Read_only

Open

Holds the level of device
authentication supported by the
service.
MSR_DA_NOT_SUPPORTE
D: The service does not support
device authentication.
MSR_DA_OPTIONAL: The
service supports device
authentication but does not
require it.
MSR_DA_REQUIRED: The
service requires device
authentication.

Yes

DeviceAuthenticationP
rotocol

Int32

Read_only

Open

Holds the device authentication
protocol supported by the

device. MSR_AP_NONE: The
service does not support device

Yes
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authentication.
MSR_AP_CHALLENGERESP
ONSE: The service supports
the challenge response
protocol.

WriteCardType string Read-Write | Open Holds the card type to be used No
the next time the write Tracks
method is called.

2.3. Events of MSR
These events are fired by the Service Object when it is necessary. The following functions are, in
fact, the event-handlers that can be added into the applications. Then the applications can receive
these events and do some processing accordingly. Please refer to the UnifiedPOS Specification for
detailed information.

1) DataEvent
Syntax void DataEvent (LONG Status);
The Status parameter contains the input status. Its value is Control-dependent.
And it may describe the type or qualities of the input.
Remarks Fired to present input data from the device to the application.
Description  a DataEvent can be received when a magnetic card is swiped if the three
conditions are all met:
1) DeviceEnabled = TRUE
2) FreezeEvents = FALSE
3) DataEventEnabled = TRUE.
The track data can be obtained, and the parsed data can also be obtained if ParseDecodeData is
TRUE.
Support? Yes

2) DirectlO Event
Syntax void DirectlOEvent (LONG EventNumber, LONG* pData, BSTR* pString);
Parameter Description
EventNumber Event number. Specific values are assigned by the
Service Object.
pData Pointer to additional numeric data. Specific values vary
by EventNumber and the Service Object.
pString Pointer to additional string data. Specific values vary by
EventNumber and the Service Object.
Remarks Fired by a Service Object to communicate directly with the application.
Description  The event DirectlOEvent is used for some special communication between one
SO and an application. Currently, this event is not fully implemented.
Support? No

3) Error Event
22
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Syntax void ErrorEvent (LONG ResultCode, LONG ResultCodeExtended,
LONG ErrorLocus, LONG* pErrorResponse);
Parameter Description
ResultCode Result code causing the error event. See ResultCode for
values.
ResultCodeExtended Extended result code causing the error event. See
ResultCodeExtended for values.
ErrorLocus Location of the error. See values below.
PErrorResponse Pointer to the error event response. See values below.
When ErrorReportingType property is MSR_ERT_TRACK, and ErrorCode is E_EXTENDED,
then ErrorCodeExtended contains Track-level status, broken down as follows:
Byte3 Byte2 Bytel ByteO
Track4 Track3 Track2 Track1
Remarks Fired when an error is detected and the Control’s State transitions into the error state.
NOTICE: The error type is only one E_FAILURE (Other or general error) while any error is
raised from reading card of SecuRED device. Because the SecuRED hardware cannot support
discerning wrong type.
Support? Yes

4) StatusUpdate Event

Syntax void StatusUpdateEvent (LONG Status);
The Status parameter is for device class-specific data, describing the type of status change.
Remarks Fired when a Control needs to alert the application of a device status change.

Note The SecuRED hardware cannot support the notification of power status change.
Description It is not implemented by the SO for the power status cannot be inquired from the
SecuRED.

Support? No
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3.

Programming Examples

There are three simple programming simple examples provided in this section
including VC++6.0, VB6.0, and VVS2005/2008 C#. The examples include basic
operations and event handling.

In general, there are two steps to work with the OPOS control object:
1. Insert the OPOS Control Object (CO) into the project
2. Add an event handle

3.1. Visual C++ 6.0 Programming Example

Programming Environment:
Windows XP Pro, Visual C++ 6.0, OPOS CO 1.13. ID TECH SO 1.13.307

1. Download the OPOS driver and demo from the IDTECH website
www.idtechproducts.com. Install the driver and make sure the OPOS demo is

functioning.

In Visual C++ 6.0, create a Dialog Based MFC application using MFC

Application Wizard with ActiveX supports.

Go to Project - Add to Project > Components and Controls. From the
“Registered ActiveX Controls” folder, select “OPOS MSR Control 1.13.001”, and
insert this ActiveX control into the project. An icon for OPOS MSR will be added

to the Controls toolbar.

k

BE 44 abl [ O X @ EH
EEm B %2 m 4 B F R
Eﬁﬂ@ﬁaﬁmm'

4. Add the OPOS MSR CO to the project dialog.
= x|
oK
Cancel
P .
mIISR
oo T S
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5. Add DataEvent and ErrorEvent handle

|CSECU[EMagOPOSEj||DC_MSR2 DataEvent j 240

-3 SecureMag OPOS example resources

+-] Dialog acureMag aXa .

+-[] lcon ]

+-[1] String Table oK
+-[[] Yersion =

T CRHRCE

void CMfc diagDlg::0OnDataEventMsrl (long Status)

6. Go the View->ClassWizard and select the “Member Variables” tab. Select
IDC_MSR and add a member variable of type “COPOSMSR”, name it m_msr.

MFC ClassWizard

Message Maps Member Variables | Automation | ActiveX Events | Class Info |

Project: Class name: Add Class... -

|SecureMag 0OPOS example |CSecureMagOPOSexampleDlg j
Add Variable...
SecureMag OPOS exampleDlg.h, SecureMag OPOS exampleDlg.cpp .

Control 1Ds: Type Member Delete Yariable

IDC MSR2 COPOSMSR m_msr
IDCANCEL

IDOK

Description:

OK | Cancel

7. Create a button on the form and add the following initialization code:
void CMfc diagDlg::OnButtonl ()

{
if (m msr.Open ("IDTECH SecuRED USBKB") == 0)
{

m msr.ClaimDevice (100) ;
m msr.SetDeviceEnabled (TRUE) ;

m msr.SetDataEventEnabled (TRUE) ;
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}
else {

// something wrong ...

8. Add code for DataEvent handle

void CMfc diagDlg::OnDataEventMsrl (long Status)
{
MessageBox (m msr.GetTracklData(), "Track 1 data");

m msr.SetDataEventEnabled (TRUE) ; // prepare the next event.

9. Compile and run the program. Compile and run the program. Click on “Button1”
to initialize the reader and swipe a card. Track 1 data will show up in a message
box.

&SEcurehhg OPOS example E|
Button1 | - __J

Track 1 data

B5150710200107747"PAYPASS /MASTERCARD ~090910140000365

3.2. Visual Basic 6.0 Programming Example

Programming Environment:
Windows XP Professional, Visual Basic 6.0, OPOS CO 1.13. ID TECH SO 1.13.307

1. Create a new project of type “Standard EXE”.

2. From Project->Components, select “OPOS MSR Control 1.13.001” and click
“apply”. The OPOS MSR icon will be added to the control toolbar.
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General |
NBEAR T
v EfER u» 2 E
OB ® -~ B m

PI5
MR

3. Add an OPOS MSR control to the form.

“DataEvent” handle.

& Project1 - Form1 (Form)

...... u B
...... oPOS. . ...l CLo
oo mMSR o m
L I;ZZZIZ;ZZIZZ;ZI B,

M Project1 - Form1 (Code)

General

KNBAR T W
FEEEEﬂHﬂE
S R E S

[
MZE

Double click on the control to add

|DPUSISRI

=] |]]a taEvent

Frivate Sub Form_Load()
End &uh

Fnd uh

4. Add the initialization code:

Private Sub Form Load()
OPOSMSR1.Open ("IDTECH SecuRED USBKB")
OPOSMSR1.ClaimbDevice (100)
OPOSMSR1.DeviceEnabled = True
OPOSMSR1.DataEventEnabled = True

End Sub

5. Add the code for Event Handle
27
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Private Sub OPOSMSR1 DataEvent (ByVal Status As Long)
MsgBox OPOSMSRI1.TracklData
OPOSMSRI1.DataEventEnabled = True

End Sub

6. Run program and swipe a card. The track 1 data will show up in a message box.

A Project1 - Form1 (Code) |:||§||X| & Form1

IForl vl ILoad vl

Private Sub Form_Load()

-

OPOSMSEL . Open (" IDTECH_EM_USEHID")
CPOSMSEL . ClaimDevice (1007
OPOSMSR] . DeviceEnabled = True
OPOSMSEL . DataEventEnabled = True

End Sub

Private Sub Form_Unload{Cancel As Integer)

OFDEMERL Close

Project1

End Sub

A B5150710200107747 “PAYPASSMASTERCARD 0903 10140000866
Frivate Sub OPOSMSE]_DataEvent{Bv¥Val Status 4s Long)

MzgBox OPOSMER]. TracklData

OPOSMSR] . DataEventEnabled = True
End 3ub
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3.3. Visual Studio 2005/2008 C# Programming Example
Programming Environment:
Windows XP Professional, Visual Studio 2005/2008 C#, OPOS CO 1.13.001 ID
TECH SO 1.13.307

1. Create a “Windows Application” Project.
2. Right click on the “Toolbox” tool bar, select “Choose item ...”. Under “COM
Components” tab, select “OPOS MSR Control 1.13.001” and click okay.

Choose Toolbox ltems

MET Framewaork Components | COM Campaonents | WPF Components

Marne Path Library ~
[] oPos LineDisplay Contral 1,13.00.,, C:\Program Files\OPOS\Commann,. ., OPOS LineDispl. .,
[] oPos MICR Control 1,13.001 [Pu... <:\Program Files\OPOSYCommoncan,.,  OPOS MICR Co..,
[] oPos MotionSensor Contral 1,13.... C:\Program Files\OPOS\Commanch, ., OPOS MokionSe. ..

|:| QP05 POSPower Control 1,13.00.,,

DPOS MSR Control 1,13,001 [Pub... CHWINDO skemn3 . OPOS MSE Con,..
|:| QP05 PINPad Control 1,10,000 [, CHOWINDOWS system32VWOPOSPINPG, .. OPOS PINPad C...
[] oPos PointCardrw Contral 1.13.... C:\Program Files\OPOS\CommanCn. ., OPOS PaintCar, .,

[ oros poskeyboard Contral 1,15, C:\Program Files\OPOSYCommonc ... OPOS POSKevh, .

Z:\Program Files\OPOSYWCommaoniZod, ..

QP25 POSPowe, .

QPSS POSPrinE. ..
OPOS Remoked...

Z:\Program Files\OPOSYWCommaoniZod, ..
Z:\Program Files\OPOSYWCommaoniZod, ..

|:| QP05 POSPrinker Conkrol 1,13,00...
[] oros RemateCrderDisplay Contr...

% >
OPDS MR Contral 1,135,001 [Public, by CRMRCS-Dayton]
e L8NQUage:  Language Meutral S
Version: 1.0

[ (] 4 H Zancel ][ Reset ]

3. Add “OPOS MSR Control” to “Form1”. Double click on the OPOS MSR Control
to add DataEvent handler code. Notice that the device name might need to be changed
for different interface.
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Forml.cs [Design]*  start Page v X

HelpProvidsr A
(=l ImageList 1
[ MessageQueus :
4 PerformanceCounter oPos

-_i Process ﬂﬂ.ﬁﬁ

s SerialPort

b28 ServiceContraller

Tirmer

[=I Printing

k Pointer

ﬂ PageSetupDialog

E PrinkDialog

L& PrintDocument

,__l PrintPreviewCantrol
a PrinkPreviewDialog

=/ Dialogs

k Painker

El ColorDialog

E FolderBrowserDialog
[47] FontDialog

|| OpenFileDialog

[£7] saveFileDialog

WPF Interoperability
= General

K Pointer
|WE OPOS MSR Control 1.13,001 [Fublic, by...| v

private void Forml Load(object sender, EventArgs e)
{
if (axOPOSMSRl.Open("IDTECH_SecuRED_USBKB") == 0)
//0 is OPOS_SUCCESS

axOPOSMSR1.ClaimbDevice (100) ;
axOPOSMSR1.DeviceEnabled = true;

axOPOSMSR1 .DataEventEnabled = true;

}
private void axOPOSMSR1 DataEvent (object sender,

AxOposMSR 1 13 Lib. IOPOSMSREvents DataEventEvent e)

{
MessageBox.Show (axOPOSMSR1.TracklData, "Track 1 data");

axOPOSMSR1.DataEventEnabled = true;

4. Run the program and swipe a card. Track 1 data will be displayed in a window.
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Track 1 data

B5150710200107 747 PAYPASS MASTERCARD ~0209 10140000866
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4. Result Code/Error Code List

const LONG OPOS SUCCESS = 07
const LONG OPOS E CLOSED = 101;
const LONG OPOS E CLAIMED = 102;
const LONG OPOS E NOTCLAIMED = 103;
const LONG OPOS E NOSERVICE = 104;
const LONG OPOS E DISABLED = 105;
const LONG OPOS E ILLEGAL = 106;
const LONG OPOS E NOHARDWARE = 107;
const LONG OPOS E OFFLINE = 108;
const LONG OPOS E NOEXIST = 109;
const LONG OPOS E EXISTS = 110;
const LONG OPOS E FAILURE = 111;
const LONG OPOS E TIMEOUT = 112;
const LONG OPOS E BUSY = 113;
const LONG OPOS E EXTENDED = 114;
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